


Overview of the PowerPoint Interrface 
 
OOvveerrvviieeww  ooff  tthhee  PPoowweerrPPooiinntt  IInntteerffaaccee  
  
Microsoft PowerPoint is an application that can help you create presentations for a variety of occasions.  
Each screen of information in PowerPoint is called a slide. A set of slides makes up a presentation called a 
PowerPoint file. This file is a computer slide show that can be presented with the computer or converted into 
another presentation format such as transparencies, handouts, or even web presentations. 
 
This workshop builds upon the concepts introduced in PowerPoint Overview, and assumes knowledge of:  

 Creating slides using PowerPoint design templates and adding content 
 Adding transitions and effects to “animate” slide content 
 Previewing your presentation using Slide Show 

 
This handout packet is designed as a stand-alone tutorial that you can use at your desktop to reinforce concepts 
covered today.  Steps you should perform appear in highlighted text throughout this handout packet. 
 

Starting PowerPoint SSttaarrttiinngg  PPoowweerrPPooiinntt  
 
⇒ Launch PowerPoint. To do this, you may either double-click on the icon on your desktop (if a shortcut already 
exists), or go to the START menu, and select PROGRAMS and then select POWERPOINT. 
 
Once you launch PowerPoint, you will see a window similar to this: 
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To create a new presentation, you can either start working with the default blank Title 
Slide, or click on “Create a new presentation…” in the Task Pane window. (If this is not 

visible, select the  arrow in the task pane to view a menu of choices.)  “Create a new 
presentation…” changes the options within the Task Pane window to the New 
Presentation options.   
 
When creating a new presentation, PowerPoint provides you with four options – Blank 
presentation, From design template, From AutoContent wizard, and From existing 
presentation.  In addition, the New Presentation window also allows you to quickly 
search Microsoft Office Online or other websites for templates, as well as allowing you to load a template that you 
have saved on your computer. 
 

 Blank Presentation – A presentation with no color, design, font, or style associated with it. You make 
all of the formatting decisions yourself. (NOTE: Although you can make changes to the slide master 
of a design template – we will edit the slide master of a blank presentation today.) 

 
 
 

 Design Template -- As the name implies, a template is a pre-designed slide 
background combined with a set of “placeholders” – or ready-made layouts. 
PowerPoint comes with a variety of pre-designed templates, which give you a 
wide range of choices for your presentations. 

 
 
 
 

 AutoContent Wizard –- Guides you through the process of creating a 
presentation, using pre-suggested formats (such as training session, company 
meeting, etc.). The wizard provides graphics and organizes your presentation for 
you.  
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Today we are going to start working with the blank Title Slide that was automatically created when you opened 
PowerPoint. 

 
 
You will notice it looks the same as other title slides, there are simply no background, font, or images associated 
with this slide.  We will work to remedy this in a moment, but first, let’s review the various PowerPoint views…  
 
The PowerPoint Interface – As A Review 
 
Although this was covered in PowerPoint Overview, as a review…when you launch PowerPoint, at the lower left 
of the screen, you will see a series of tiny icons that let you view your presentation in different ways. Although 
these icons are tiny, they are very important for navigating around PowerPoint. When you point the mouse on an 
icon, a label appears to show you what it is. From left to right, these icons represent the following: 
 
     *Normal View --  -- Allows you to see the text of your presentation and the current slide as you are 
developing the presentation. You can edit in the slide area, and the notes area. 
 
     *Slide Sorter View--  -- Used to see all the slides in the presentation and change their order, apply a design 
template to the whole presentation, or to define transitional effects for individual slides or the entire presentation. 
 
     *Slide Show --  -- Allows you to preview or actually give your presentation.  This is a good view to use after 
you have defined transition effects and would like to see how they look. 
 
At the top of the left window, you will find two tabs, with two additional icons designed for navigating within slides.  
Like the icons at the bottom of the window, when you point the mouse on an icon, a label comes up to show you 
what it is. 
 

     *Outline Tab --  -- Allows you to edit the slide by typing in the left window, as opposed to typing text 
in on the slide.  Using this view allows you to concentrate on the content and organization of your presentation 
first, before thinking about graphics. 
 

     *Slide Tab --  -- Allows you to edit directly on a slide.  This is a good view to use when you want to 
focus on one individual slide and make some changes to it that you probably will not make to other slides.  You 
may want to edit the text, change the font or size, or add clip-art. 
 
You will go between these different views as you create your presentation. Now, let’s start working on your 
blank presentation!  
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CCrreeaattiinngg  aa  MMaasstteerr  SSlliiddee  
 
Once you have decided to work with a blank presentation, you need to work to design a master slide.  (Unless, of 
course, you want a very simple plain black-and-white presentation without graphics, background colors, or special 
fonts.) 
 
The slide master contains text placeholders and placeholders for footers, such as the date, time, and slide 
number. When you want to make a global change to the look of your slides, you don't have to change each slide 
individually -- just make the change once on the slide master, and PowerPoint automatically updates the existing 
slides and applies the changes to any new slides you add. For instance, if you wanted to have specific text or a 
piece of clip art — such as the UM logo — appear on every slide, you would put it on the slide master. Objects 
appear on slides in the same location as they do on the slide master. When you change the slide master, changes 
you have made to individual slides are preserved. 

So, you would typically go to the slide master to do the following: 

 Change the font or bullets  
 Insert art — such as a logo — that you want to appear on multiple slides  
 Change placeholder positions, size, and formatting  

 
Let’s see how to make these changes… 

⇒ To see the slide master, you display master view.  To do this, go to View  Master  Slide Master.  
 

 
 

You can make changes to the slide master just as you would change any slide, except remember that the text on 
the master is only for styling; actual slide text, such as titles and lists, should be typed on the slide in normal view 
or, for headers and footers, in the Header and Footer dialog box. (We will cover headers and footers on page 8.)  

 When you are finished editing the slide master, you will click the Close Master View button in the Slide Master 
View box to return to the presentation. (We will cover this in more detail on page 11.) 
 
EEddiittiinngg  AA  MMaasstteerr  SSlliiddee  
  
As mentioned above, editing a slide master uses the same process as you would use to edit individual slides. The 
difference is that changes you make to the master will appear on every slide. Areas you may wish to change in 
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your slide master include the slide background and font. You may also wish to insert Word Art, pictures or clip 
art, or create lines or other shapes on your slide master, for emphasis. Let’s see how these work… 
 

Formatting The Slide Background  
 
You can change the appearance of your slide background by changing its color, shade, pattern, or texture. You 
can also use a picture as a slide background, but you can use only one type of background on any single slide or 
master. 
  
⇒ Choose Format  Background. The Background dialog box will appear. 
 
⇒ Under Background fill, click the down arrow.  

 
 To change to a color in the color scheme, 

click one of the eight colors below 
Automatic. 

 
 To change to a color that isn't in the color 

scheme, click More Colors... Click the color you want on the Standard tab, 
or click the Custom tab to mix your own color, and then click OK.  

 
 
 
 

Hint: For this exercise – you may want to choose a color in the “yellow” family… 
 

 Click the Preview button to see how this change would appear on your slide background. Revise 
your color choice as needed.  

 
 To change the background color back to its default, click Automatic. 

 
The Fill Effects menu offers many options for Gradient, Texture, Pattern or Picture.  
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Let’s see what each of these options would do… 
 
Gradient tab 
Gradient shading is one of the most frequently used effects, and allows you to add dramatic shading to 
your backgrounds (or objects). If you want to use this feature, select the Gradient tab and note the 
choices available for colors, shading styles, and variations.  

 For colors, select One color if you want the color chosen to fade into 
the background. Select the color from the Color 1 drop-down menu. 
Choose Two colors if you want to use two colors. Select those 
colors from the Color 1 and Color 2 drop-down menus. The Preset 
option provides a selection of color combinations. Select one from 
the Preset colors drop-down menu.  

 Select the type of gradient (horizontal, vertical, etc.) from Shading 
styles.  

 Click one of the four Variants of the styles chosen. 

 A small sample of your work will appear in the Gradient window. When you are satisfied with your 
choices, click OK. If you decide not to add a gradient effect, click Cancel to return to the 
Background menu.  

 
Although we will not change the following settings in class, as alternatives to setting a background color and 
gradient, you may choose to set instead the texture or the pattern of your slides, or you may insert a picture as 
your background. We will briefly review these options now… 

 
Texture tab 
From the Texture window, you would select a repeating background 
by scrolling through the thumbnail images or click Other Texture... 
to select an image from a file. Once you have selected a texture 
that you would like to apply to all of your slides, you would click OK.  

 
 

Pattern tab 
Using this feature, you can select a two-tone pattern by clicking one 
of the pattern swatches and selecting the Foreground and Background colors.  Click OK when you find 
a pattern that suits your presentation. 

 
Picture tab 
Click the Select Picture button to choose a picture from a file.  After the picture is selected, a preview 
and description will be shown in this window. (Remember, this will cover the entire background of your 
slide. To insert a smaller picture or clip art on the slide master, see page 9.) 

 
⇒ Click OK to apply the changes made from the Fill Effects windows. 
 
⇒ After you have made your background selections, click Apply to All. If you need to revise any of the settings 
chosen, you can return to Format  Background at any time. 
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Formatting Slide Fonts 
 
In the slide master, you can change the fonts and font attributes (size, bold, italic, color, etc.) for the entire 
presentation.  
 
⇒ In the slide master, select the text that you would like to change (either the title, or individual bullet points). 
 
⇒ Choose Format  Font. From the Font dialog 
box you can change the font, size, style or color, 
and add effects such as underline or sshhaaddooww.  
 
As a reminder – any changes you make to the font 
style will appear automatically on all slides in your 
presentation!  
 
⇒ When you are satisfied with your font selection, 
click OK, and repeat as needed for the other text 
placeholders on your slide. Once you have closed 
the Font dialog box, you can also center or left-justify your title if you desire. 

 

NOTE: A faster way to add consistency to your presentation is through the pre-defined design. They can be 

applied by clicking on the Design button  in the toolbar, and selecting a presentation design from the list 
that appears in the Task Pane. 
  
  

OOtthheerr  CChhaannggeess  ttoo  tthhee  SSlliiddee  MMaasstteerr  
 

Headers and Footers 

If you desire, you can easily add the date and time, slide numbers, and other footer text to the master slide using 
the Header and Footer window. To do this: 

⇒ Select View Header and Footer... from the menu bar. The Header and Footer dialog box will appear. 

 Check the Date and time box to add this 
feature to the slide. Select Update 
automatically to always display the 
current date and time or click Fixed and 
enter a date that will not change in the text 
field provided.  

 Check the Slide number box 

 to add this feature to your 
slides. 

 Click the Footer box and add other text to 
the footer area of the slide.   

o For this presentation, add the footer UM Libraries. 
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 Check the Don't show on title slide box to hide these features on the title slide of the 
presentation.  

⇒ Click Apply to All when you are happy with your selections. 

 

SOME SPECIAL NOTES ABOUT HEADERS AND FOOTERS:  

The changes you are making to headers and footers can be done outside the slide master as well. Some helpful 
hints for using headers and footers include: 

* Click the Notes and Handouts tab in the Headers and Footers box to make the same changes to your notes 
and handouts pages.  

* The slide number can otherwise be added anywhere on the slide by placing the cursor where the slide number 
should appear and selecting Insert Slide Number from the menu bar. The text of the slide number can be 
formatted just as regular text style is changed. 

* To insert the date and time elsewhere on a specific slide (not through the slide master), you can place the cursor 
where the date and time should appear on the slide and select Insert Date and Time from the menu bar. 
Select a format from the Available formats box and click Update automatically if this feature should always be 
updated to reflect the current date and time. Click OK to finish. 

 

Adding Images TTo Yourr Slide Master AAddddiinngg  IImmaaggeess  Too  YYoouur  SSlliiddee  MMaasstteerr  
 
You can add either pre-designed clip art (provided by Microsoft) or your own picture or image to a slide to clarify 
an idea or emphasize a point. PowerPoint allows you to insert the following items – several of which we will cover 
in class today: 

 
* CLIP ART – select a picture from Word’s clip art gallery  
* FROM FILE – select a picture saved on your computer 
* FROM SCANNER OR CAMERA – to insert a digital image 
* NEW PHOTO ALBUM - add a large group of your favorite pictures to a 
presentation 
* AUTOSHAPES – bring up the AutoShapes toolbar and insert shapes that 
can contain text 
* ORGANIZATIONAL CHART – chart an organizational hierarchy 
* WORDART – create text effects using the WordArt toolbar on words you 

enter 
 
In order to insert any of these types of graphics into your slide master or individual slides, choose Insert  
Picture.  
 
Inserting Clip Art 
 
To insert a clip art item into the slide master, do the following: 
 
⇒ Open the clip gallery by choosing Insert Picture Clip Art.  
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⇒ This changes the Task Pane window to the clip art menu.  Use the Search box to search by keyword.  
 
⇒ Click on the clip art you would like to use to add it to the slide. 

⇒ To move the picture, just click and drag. (Make sure you see a crosshair icon , which stands for Move.) To 
resize the picture, drag one of the square corners on the border of the image. (For more information about editing 
graphics, see page 17). 
 
 
Inserting Your Own Picture 
 
To add your own image instead of one from the Clip Art collection, follow these steps: 

⇒ Click on Insert Picture  From File. 

⇒ Locate the image on your computer as you would in other programs. Click on Insert.  You can then resize or 
reposition the picture the same as you would the clip art.  
 

 For our presentation – insert a picture from the desktop by selecting Desktop 

 from the “Look In” menu. 
 Select the testudo image, and click Insert.  
 Resize the image so that it fits in the lower-right corner of your presentation.  

 
Helpful Hint: You can also Copy and Paste an image from a Word document!   

 

WordArt 

You can also add headlines in striking colors and shapes to your slide 
master using WordArt. 

⇒ Select Insert  Picture  WordArt from the menu bar or click 

the WordArt button  on the Drawing toolbar. 

⇒ Choose a WordArt style from the listing and click OK.  
 

⇒ Enter the text in the Edit WordArt Text box and choose the font, size, and style for the text. Click OK. 

 For our presentation, select a style of WordArt that appeals to you, and click OK.  

 In the Edit box, type Fall 2004 – and size the font to 28 point.  

 Use the white box handles around the word art to resize it on the slide, and move it to the lower left 
corner of your slide.  
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Adding Graphic Objects  
 
In addition to changing the background color and fonts of your slide master (and/or adding clip art, WordArt, or 
photos), you may want to add additional graphical content to your slide master. To do this, use the Drawing 
Toolbar (that is also found in MS Excel and MS Word) and make use of the tools it provides to draw arrows, lines, 
circles, and more. 
 
⇒ If it is not already active, go to View  Toolbars  Drawing to affix the Drawing Toolbar to the lower edge 
of the PowerPoint window. 

 
 

 Using the Line tool , draw a line at the top of the slide master, between 
the title and text.  

 Once you have drawn the line, you may choose a different width using the 

Line Style tool . 

 Apply a color to your line using the Line Colors  tool. PowerPoint 
automatically selects several colors for you, but to select a specific color, 
choose More Line Colors.  You can also select Patterned Lines to add a 
pattern to your line. 

 
(If you would like, while the line is still selected (notice the selector handles at both ends of the line), click on the 

Dash Style tool  and select a dashed line style.) 
 
 
SSaavviinngg  CChhaannggeess  ttoo  tthhee  SSlliiddee  MMaasstteerr 
Once you have made all of the changes you wish to the slide master, click on Close Master View 

 in the Master tool bar. You will be returned to the normal view of your presentation, and will see 
your background colors and clip art images present in your slide master. As you add text to your slides, you will 
note it will appear in the font style you selected. 
 
If you need to edit your slide master, simply go back to View  Master  Slide Master and make the needed 
changes. 
 
⇒ Although we have actually not started to work on our presentation itself – let’s SAVE all of the changes we 
have made via the slide master! Go to File and select Save As. Scroll to the A: drive, and save on your diskette 
as intermediatepowerpoint. Do not type a file extension; PowerPoint automatically adds the extension .ppt.  
 
Now that you have named your presentation and saved it, you can save any changes you make from here on out 

by clicking the Save button  on the toolbar. 
 
CCrreeaattiinngg  YYoouurr  PPrreesseennttaattiioonn  
 
Once you have formatted the slide master to your satisfaction, you can then edit your presentation.  
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⇒ Click on the Normal View icon.  Select the Outline Tab. 
 
⇒ Begin typing the text of your presentation in the left-hand side of the screen. The first slide you will work on will 
be the title slide.  Include the title of your presentation, your name, the date, and anything else you want to 
include.   (As a reminder, in title slides, PowerPoint does not add bullets to indented items.) 

 
⇒ After you type the first line of text, click in the second box on the title slide itself to continue entering text.  This 
is where you can add your second line of text, such as your name.  Press Enter to go to the next line within the 
box. (NOTE: When you hit Enter while still in the main title box, a new slide number will appear, so you will need 
to click with the mouse in the second box to continue working on the title slide.) 
 
⇒ To make the next point an indented subtopic under the first line, press Tab. Pressing Tab again will indent one 
more level.  
 
⇒ To move back to the left, press Shift-Tab.  (NOTE: If you have only indented one level, Shift-Tab will start a 
new slide.) 
 

NOTE: The little slide icon you see in the outline  means that a new slide is starting. If there is no slide icon 
in front of a line of text, it will be added to the current slide. To get an idea of how the text will look on the slide, 
look at the slide on the right side of the screen.  
 
Helpful Hint: When in the Outline View, you have the choice of editing text in the slide itself on the right side of 
the screen, or in the text area to the left. 
 
⇒ If you have not already done so, create a second slide, which will be a “content” slide. To create a new slide, 
you may either:  
  Shift + Tab in the outline view. 
  Choose Insert  New Slide from the menu bar. 
  Use the Ctrl + M keyboard shortcut. 
  Select “New Slide” in the toolbar. 
Once you have created a new slide, the Task Pane window changes to the Slide Layout menu.  Choose any type 
of AutoFormat you would like – although a bulleted list (called “Title and Text” in the Task Pane) might be the 
easiest to use.  
Helpful Hint: While one of the AutoLayout options is for a “blank slide” to which you can add text by inserting a 
Text box – this text will not appear on your outline, and will not be scanned by the spell check feature (see 
“Presentation Pointers” – Page 12). Instead, choose an AutoLayout that best matches what you would like your 
slide to look like, or insert text in the Outline. 
 
⇒ Once you have inserted a new slide, enter a title for your slide. Press Enter and then Tab to go to the next 
line. Type your text, and press Enter to go to the next bullet. 
 
⇒ Press Tab to indent to the right (for a subtopic). 
 
⇒ Press Shift/Tab to move to the left (to go to a higher level of the outline). 
 
Helpful Hint: You can decide whether you prefer the text area or the slide area to be bigger.   For the slide area 
to be larger than the text area, use Normal View. If you prefer a larger area for the text, use Outline View. 
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⇒ Create a total of three slides for your presentation – one title slide, and two “content” slides. Notice how the 
design of the template changes between the “title” and “content” slides.  
 
Helpful Hint: Once you have started to create your presentation, you can click on the different view icons to 
display your presentation in different ways.  Remember, Outline View is useful for creating the basic content and 
organization of the presentation without the distractions of fancy graphics. When you have completed a rough 
draft of the content, then you can go to Slide Sorter View to add effects, rearrange slides, or change a design 
template. To see only one slide at the largest possible size, use Slide View.  This is a good one to use if you want 
to add a picture to a slide.  To test or actually deliver your presentation, use Slide Show View.   
 
⇒ When you have finished creating the three slides in your presentation, go to the Slide Sorter View.  You will 
see all the slides in your presentation.  

 
If you want to change the order of any of your slides, you can just drag-and-drop them where desired. 
 Place your mouse pointer on the slide you want to move. 
 Hold down the left mouse button 

Drag the mouse pointer to the new position; you should see a vertical line indicating the placement of 
the slide 

 Release the mouse button. 
 
Let’s use this trick to create a “close” to your presentation by copying the “title” slide.   
 
⇒ In the Slide Sorter, highlight the title slide.  
⇒ Go up to the Edit menu, and select Copy. Use your mouse to position the cursor after the last slide. You 
should see a vertical line, indicating placement of the slide.  

 

⇒ Go back to the Edit menu, and select Paste.  
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⇒ Don’t forget to SAVE your presentation! Click the Save button on the toolbar to save your changes . 
  
SSaavviinngg  YYoouurr  PPoowweerrPPooiinntt  PPrreesseennttaattiioonn  TToo  TThhee  WWeebb  
 

While you will likely take your presentation with you on disk or CD, there are times you may need to make a 
presentation available online. Luckily, it is possible to put a version of your PowerPoint presentation on the web. 
You have two options available to you to do this: by creating a PDF of your presentation, or by saving your 
presentation in HTML format through PowerPoint. Let’s review both options.  

Saving Your Presentation As An Adobe Acrobat File 

The simplest method for saving your presentation to the web is to convert it to a PDF file, and then load it via 
WebSpinner. This requires that you have Adobe Acrobat installed on your machine (not just the Acrobat 
Reader). If you do not have Acrobat on your machine, you will need to request a copy from ITD. (The online 
“Software Request Form” is available at: http://www.lib.umd.edu/itd/help/SOFTWARE/Request.htm).  

⇒ Click on the Convert to Adobe PDF button  on your toolbar. (If this is not visible, go to View  Toolbars 
and select PDFMaker.)  

⇒ The Save PDF File As dialog box will appear. 
Be sure to note the location where you are saving 
this file, and be sure that the File Name is one 
word (without spaces), and the Save as Type is 
PDF files.  

Once you click Save, the Acrobat dialog box will 
appear, showing your progress.  

 

 

 Once the file has been saved, you can load the file into WebSpinner. To do this, go to 
http://www.lib.umd.edu/cgi-bin/WebSpinner and log in as yourself. (If you do not have a WebSpinner 
account, contact Gary Phillips at garyp@itd.umd.edu or at X 5-9025). 

 Select the appropriate directory where you want to load your presentation. 

 Select New File , and enter the File Name (which must end in .pdf).  

 Click on Browse to upload the local file to the server.  

 Click on Create File. Your file should appear in the file list box. You may then log out of WebSpinner, 
and type in the URL of your presentation into your web browser to view it (remembering that it will 
end in .pdf).  If you need to make changes to your presentation, you simply re-save it as a PDF, and 
re-load the file to the server. 
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A sample copy of the presentation created for class is available as a PDF online at: 
http://www.lib.umd.edu/groups/learning/IntermediatePowerPoint.pdf 
Note that each slide in the presentation is saved as a separate page, and the presentation can be printed.  

Saving Your Presentation As A Web Page 

 
The second option for making your presentation available on the web is to save it as a web page through 
PowerPoint. In this process, a copy of all the files - text, images, and graphics - used in your presentation is 
automatically created. Each of these supporting files, along with the presentation, must then be loaded onto the 
website via WebSpinner. 
 

HINT: To make sure your presentation looks the way you want in your Web browser, preview your presentation as 
a Web page before you publish it. To do this, go to File  Web Page Preview. This will open your presentation 
in your default Web browser.  

⇒ Go to File, and select Save As Web Page.  

⇒ This will open up a Save As dialog box.  Be sure to note where you are saving your presentation. You can edit 
the Page Title by choosing the Change Title button.  

 

Be sure that the File name is entered as one word (without spaces) and that the Save as type option is set to 
Web Page.  

⇒ In order to better control your presentation options, 
choose the Publish… button.  

⇒ The Publish as Web Page dialog box will appear. You can 
choose to publish your Complete Presentation, or specific slides.  
If you have a great deal of information available in your notes 
pages, you can choose to Display speaker notes as well.  

 ⇒ You may also choose to edit the Web Options 

, such as turning on or off slide navigation controls 
or animations. (Note: adding these features will create additional 
supporting files for your presentation.)  

Select the options you want.  

⇒  Once you are satisfied with the settings, click Publish. This will take some time, so be patient! 

HINT:   To see how your published Web presentation looks in your browser, select the Open published Web 
page in browser check box in the Publish as Web Page dialog box. 

⇒ After saving your presentation, you will need to log into WebSpinner and load it onto the website.  
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IMPORTANT NOTE:  When you save a presentation as a Web page, all supporting files — such as bullets, 
background textures, and graphics — are by default organized in a supporting folder. You must copy all of the 
items in the supporting folder so that the presentation will display. 

 Part I: FTP Files to the Server 

o Contact Gary Phillips (garyp@itd.umd.edu or at X5-9025) and ask for the address and specifics 
to establish an FTP session to the Libraries’ server.  

o Create a folder in the incoming directory for your files (so they will be easier for you to locate and 
upload in WebSpinner), and transfer your files via FTP. (Note: The files you FTP to the 
“incoming” directory will be automatically deleted in 14 days, so you do not have to worry about 
file cleanup.) 

 Part II: Upload files on WebSpinner 

o Go to http://www.lib.umd.edu/cgi-bin/WebSpinner and log in as yourself. (If you do not have a 
WebSpinner account, contact Gary Phillips at garyp@itd.umd.edu or at X 5-9025). 

o Select the appropriate directory where you want to load your presentation (or create a new 

directory by clicking on MKDIR ). 

o Click on Upload . Navigate to the folder you created in the Incoming directory and 
highlight that name in the window at the center of the screen. Click Upload File/Directory 

. Your file should appear in the file list box for that directory. Note the 
URL of your presentation.  

o Log out of WebSpinner and test your presentation, using the URL generated by WebSpinner.   

A test presentation is available online, which shows what the same PowerPoint presentation saved as a PDF 
looks like when saved in HTML format. Note the long URL, necessary because PowerPoint created a number of 
“support” files for the presentation:  
 
http://www.lib.umd.edu/groups/learning/Intermediate/Intermediate/IntermediatePowerPoint
_files/IntermediatePowerPoint.htm 
 
Notice that the web-based presentation looks quite different from the way the presentation looks during a normal 
presentation. Using the mouse, you may click on the action buttons (at the bottom of the window) to advance from 
slide to slide. You may also click on the slide titles to jump from slide to slide. 
 
NOTE: Since this process is so complex, unless you are very comfortable using FTP programs, you may wish to 
follow the directions on page 13 for saving your presentation as a PDF. If you have questions regarding how to 
FTP documents to WebSpinner, contact Gary Phillips at garyp@itd.umd.edu or at X5-9025.   
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Practicing and Developing Your Skills PPrraaccttiicciinngg  aanndd  DDeevveellooppiinngg  YYoouurr  SSkkiillllss  
 
Presentation Pointers   
 
One good way to continue developing your skills is to PRACTICE!  The next time you create a presentation, try to 
keep the following in mind: 
 

 Be careful not to overwhelm your audience with too much information! Simplicity is always best. 
 Keep text and fonts simple and easy to read.  
 Use only a few lines of text per slide, and leave some empty space on each slide. 
 Use phrases with a few short words – rather than sentences. 

 Remember – your presentation needs to be viewed by an audience at a distance, and this 
audience only has a few moments to grasp the information that the slide conveys. 

 Present one statement or concept per slide and show only a few lines of text or data sets per image. 
 Use color to help you communicate more effectively – but limit your choice of colors to 3 per slide.  
 Be consistent throughout your presentation – use the same colors, graphic style, and text fonts.  

 Jumping from style to style can be confusing to an audience. 
 
Once you have created the “perfect presentation” - be sure to preview the slide show using (if possible) the same 
projector that will be used during the presentation. The projector may cut off words or graphics that are close to 
the edge of the screen, and it is better to know this beforehand, so you can edit individual slides accordingly. 
 
 
Slide Color Schemes    
 
As an alternative to setting the background color and fonts on individual slides (or in the slide master), you may 
wish to instead edit the color scheme of your presentation. To do this: 
 
⇒ Select Format  Slide Design from the menu bar, and choose Color Schemes  from the 
task pane.  
⇒ Click one of the preset color scheme thumbnail images in the Apply a Color Scheme box. 
⇒ To create your own color scheme, click the Edit 
Color Schemes… at the bottom of the task pane.  

 Change the colors of the slide elements by 
selecting the color swatch beside the name 
of the element and clicking the Change 
color button.  

 Click Apply when finished.  

⇒ When you have finished all color formatting, click 
Apply. 

 
NOTES: 
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Inserting A Link To A Web Page In A Powerpoint Presentation 

⇒ Select the text or object you want to represent the hyperlink.  

 Go to Insert  Hyperlink.  
 On the Insert Hyperlink menu that appears, locate and select the Web address you would like to 

appear. You can do this by doing one of the following:  
o Type the Web page address in the box provided.  
o Select the Web page from the list provided.  
o Click on Web Page to open your Web browser. Browse to the Web page you want, and then 

press ALT+TAB to switch back to PowerPoint. The address of the Web page is displayed in 
the Type the file or Web page name box.  

 Click OK.  
 

Hyperlinks become active when you run the slide show. To preview and test the hyperlink, click Slide Show at the 
lower left of the PowerPoint window.  

When you present the slide show, click the hyperlink to display the Web page. When you're done showing the 
Web page to your audience, press ALT+TAB to switch back to the slide show. 

NOTE:  You can also create a hyperlink to an existing Web page by typing the URL on a slide or in the outline. 
For example, type http://www.microsoft.com/ on a slide, and the hyperlink is created automatically. 

 

Editing A Graphic  

Once you have inserted a graphic into your presentation (either through the slide master or on an individual slide), 
you may wish to make changes to its size or appearance. To do this, activate the image you wish to edit by 
clicking on it once with the mouse. Several handles will appear around the graphic. Click and drag these handles 
to resize the image. The handles on the corners will 
resize proportionally while the handles on the straight 
lines will stretch the image. More picture effects can be 
changed using the Picture toolbar.  

 18 

To format a graphic, you can also right-click on it and choose Format Picture  from the 
context-sensitive menu. This will bring up the Format Picture menu, 
which will allow you to change the color, size, layout, and other aspects of 
the picture.  

The Position tab allows you to determine the picture’s location on the 
slide. Choose the Scale option on the Size tab to resize your picture (be 
sure that the “Lock Aspect Ratio” box is checked, so that your picture will 
be resized proportionately). 

PowerPoint Intermediate – UM University Libraries  



You can also move your picture by selecting it, and when the mouse pointer turns into a four-h
and drag the picture where you want it.  

eaded arrow, click 
  

   
Adding Animation  
 
As you may recall from PowerPoint Overview, there are two ways to add “animation” to your 
presentation. The first is with a transition, which controls the way slides appear as you 
advance through your presentation.  The second way to add movement to your slide is 
through an effect. An effect “builds” a slide one element at a time. You can choose to 
animate text, charts, or clip art. (You can even animate features on the slide master!) 
 
One way to add transitions and effects to your presentation is through the slide sorter view. 

Click on the Transitions button  on the toolbar to change the options in the Task 
Pane window to the Slide Transitions menu. 
 
The first set controls how a new slide will enter the screen. The second set controls how 
quickly the transition takes place, and whether or not a sound is played when the transition 
takes place.  You can choose to have your slides advance on your mouse click, or have t
automatically advance after a set period of time.  You can click the “Apply to All Slides” 
button or use Control-A to select and apply transitions to your entire presentation, or you can make changes to 
one slide at a time. 

hem 

 
You can choose to add transitions to one, a few or all slides in your presentation. Add different transitions to each 
of your slides, Save the changes, and use the Slide Show to preview them.  (As a reminder…when you’re 
experimenting, it is OK to have different effects for every slide, but in your final presentation, this could be 
distracting for your audience!) 
   
   

Ac es ing PowerPoint Help AAccccceesssssiinngg  PPoowweerrPPooiinntt  HHeellpp  
   
There are a number of ways to access help features within PowerPoint. 

• To open the PowerPoint Help task pane:  

o Press F1, 

o Click on the Help button  on the Standard Toolbar, or  

o Go to the Help menu and select Microsoft Excel Help.  

 

You can also:  

• Double-click on the Office Assistant. A dialog box will appear for you to enter 
your query. Click Search when ready. [If the Office Assistant is not visible, go 
to the Help menu, and select Show the Office Assistant.] 

• Type in a keyword or phrase in the Search for: box 

, located on the right side of the menu bar and 
press Enter. 
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Additional Resourrces AAddddiittiioonnaall  RReessoouurcceess  
 
There are several books available for you to check out from the Learning Curriculum Resource Library:  
 
Haddad, Alexandria. Teach Yourself Microsoft PowerPoint 2000 in 24 Hours. Indianapolis, IN: Sams, 1999.  
 
Perry, Greg. Teach Yourself Microsoft Office 2003 in 24 Hours. Indianapolis, IN: Sams, 2004.  
 
Wempen, Faithe. Teach Yourself Microsoft PowerPoint 2000 in 10 Minutes. Indianapolis, IN: Sams, 1999. 
 
[Note: Although most of these books deal with PowerPoint 2000, many of the basic skills and options have not 
changed in PowerPoint 2003.] 
 
Other tutorials available online include: 
Getting Started with PowerPoint 2003, Wellesley College:  
http://www.wellesley.edu/Computing/Office03/Powerpoint03/general.html 
Microsoft PowerPoint 2003, University of Wisconsin, Eau-Claire: 
http://www.uwec.edu/help/ppoint03.htm  
PowerPoint Training from Microsoft:   http://office.microsoft.com/en-us/FX010857971033.aspx 
 

A complete listing of titles in the Learning Curriculum Resource Library is available at: 
http://www.lib.umd.edu/groups/learning/lcrlibrary.html. 

 
 
CREDITS: 
Material in this handout packet adapted from the Haddad and Wemben titles listed above, as well as from: 

• University of Miami Department of Information Technology – Microsoft PowerPoint 2000 Manual 
(available online at: http://www.it.miami.edu/classes/pdfs/powerpoint_manual.pdf). 

• Microsoft PowerPoint Quick Start guide from the University of Kentucky (available online at: 
http://www.uky.edu/IS/Training/Handouts/PowerPoint2000QS_HANDOUT.pdf).  

• PowerPoint 2000 Tutorial – Florida Gulf Coast University (available online at: 
http://www.fgcu.edu/support/office2000/ppt/).   

The handout was updated for PowerPoint 2003 by Jennifer Muter, Staff Learning and Development, in October 
2004. 
 
 
 
 
 
 
 
 
 
 
 
 
 
Rev. 10/21/04 
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